
#QBVcon

QuickBooks 2018

What’s New          

and Improved



Laura Madeira

ACS, Inc. Intuit Premier Reseller

Top 10 and Top 100 QuickBooks ProAdvisor

QuickBooks Advanced Certified

QuickBooks Author and Trainer

Office: 214-705-9192

laura@quick-training.com

www.quick-training.com

mailto:laura@quick-training.com
http://www.quick-training.com/


#QBVcon

Intuit Proprietary and Confidential

Agenda

What’s New and Improved - Desktop

ProAdvisor Program - QuickBooks 

Accountant ToolBox Access



#QBVcon

Intuit Proprietary and Confidential

CPE Process

This session is eligible for 1 hour of CPE

• You must stay in the session for the duration of the training

• There will be CPE polling questions that will be pushed out during the 
session.  In order to qualify for CPE, you must respond to all polling 
questions during the session.  

• CPE certificates will be emailed directly to you within 7 business days of 
the conference date to the same email address you used to register
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Learning 

Objectives

• Identify new and improved features that will help you and your 

clients work more efficiently using QuickBooks Desktop 2018

• Review the benefits of the QuickBooks ProAdvisor Membership 

with access to the Accountant ToolBox



QuickBooks Desktop 2018

What’s New and Improved
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Multi-Monitor Support

WHAT’S NEW AND IMPROVED FOR QUICKBOOKS DESKTOP 2018
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Prior Versions of 

QuickBooks

WHAT’S NEW AND IMPROVED FOR QUICKBOOKS DESKTOP 2018

Working with open windows 

side-by-side in QuickBooks was  

limited to the open area in the 

QuickBooks workspace.

Multi-Monitor Support



#QBVcon

Intuit Proprietary and Confidential

Move Open 

Windows to 

Connected Monitors

WHAT’S NEW AND IMPROVED FOR QUICKBOOKS DESKTOP 2018

Enable, in View > Switch to Multi-

monitor Mode (or use Ctrl+Alt+M)

Works on up to three connected 

monitors

No need to drag and drop, just 

click the Move button or use the 

keyboard shortcut

Multi-Monitor Support
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Proper Monitor 

Display Alignment 

Required

WHAT’S NEW AND IMPROVED FOR QUICKBOOKS DESKTOP 2018

When using connected 

monitors, the displays must 

align at the top or the or on the 

left sides

Multi-Monitor Support
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Improved 

Productivity

WHAT’S NEW AND IMPROVED FOR QUICKBOOKS DESKTOP 2018

Work more efficiently by 

keeping multiple QuickBooks 

windows open on connected 

monitors

Multi-Monitor Support
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Visual Reminder to 

Pay Payroll Liabilities

WHAT’S NEW AND IMPROVED FOR QUICKBOOKS DESKTOP 2018

Enhanced Payroll Subscription 

required

Red badge on the Pay 

Liabilities icon displays 7 days 

prior to a scheduled payroll 

liability due date

Payroll Liability Reminder Badge
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Pay Liabilities Tab 

Badges Visible on 

Due Date or Overdue

WHAT’S NEW AND IMPROVED FOR QUICKBOOKS DESKTOP 2018

The Pay Liabilities tab will only 

include a badge when the 

liability is due now or past due

The Home Page badge picks 

up the reminder 7 days in 

advance

Payroll Liability Reminder Badge
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Past Due Stamp –

Screen, Printed or 

Emailed Invoices

WHAT’S NEW AND IMPROVED FOR QUICKBOOKS DESKTOP 2018

Past Due Stamp is visible on 

screen for invoices with past 

due amounts

Past Due Stamp on Invoices
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Template Preference 

to Include Past Due 

Stamp

WHAT’S NEW AND IMPROVED FOR QUICKBOOKS DESKTOP 2018

Setting included in form 

templates - determines if the 

Paste Due stamp will be 

displayed on emailed or printed 

invoices

Turn on or off display of the 

Past Due Stamp for a selected 

invoice

Past Due Stamp on Invoices
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Merge Duplicated 

Vendor Records

WHAT’S NEW AND IMPROVED FOR QUICKBOOKS DESKTOP 2018

Access from:                

Accountant > Client Data 

Review > Merge Vendors

Available in QuickBooks 

Accountant, QuickBooks 

Enterprise, or with your 

Accountant ToolBox access in 

QuickBooks Pro or Premier

Merge Vendor Records
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Search and Sort 

Vendor List

WHAT’S NEW AND IMPROVED FOR QUICKBOOKS DESKTOP 2018

Merge Vendor window permits 

search based on fields:

• Vendor Name
• Company Name
• Billed From

Click on column header to 
simplify finding duplicated 
records

Merge Vendor Records
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Select a Master 

Vendor – Remaining 

Vendor

WHAT’S NEW AND IMPROVED FOR QUICKBOOKS DESKTOP 2018

After selecting the vendor 

records to merge

Assign one record as the 

Master Record (this will be the 

remaining vendor record)

Merge Vendor Records
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Optionally Update 

Vendor Record 

Fields

WHAT’S NEW AND IMPROVED FOR QUICKBOOKS DESKTOP 2018

Selected fields of the Master 

Vendor record that can be 

updated before merging include:

• Company Name

• Billed From

• Main Phone

• Vendor Tax ID

• And many more…

Merge Vendor Records
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Information Merged

WHAT’S NEW AND IMPROVED FOR QUICKBOOKS DESKTOP 2018

For the selected Vendors, all 

previous transactions will 

merged into the selected 

Master Vendor Record

Use caution, as this step cannot 

be undone

Merge Vendor Records
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Vendor Information 

Not Merged

WHAT’S NEW AND IMPROVED FOR QUICKBOOKS DESKTOP 2018

Selected information is not

merged including:

• Notes

• Contacts

• To Do’s

• Sent Email List

• 1099 Tax Forms already filed

Merge Vendor Records
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Copy and Paste 

Line Keyboard 

Shortcuts

WHAT’S NEW AND IMPROVED FOR QUICKBOOKS DESKTOP 2018

Ctrl+Alt+Y to copy a line

Ctrl+Alt+V to paste the line

Use with:

• Estimates

• Sales Receipts

• Sales Orders

• Credit Memos

• Purchase Orders

• Timesheets

Copy and Paste Line Keyboard Shortcuts
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Cash / Accrual 

Toggle on Reports

WHAT’S NEW AND IMPROVED FOR QUICKBOOKS DESKTOP 2018

Without customizing the report, 

users can toggle between both 

Cash or Accrual basis reporting

Available with those reports that 

offer the option to view in Cash 

or Accrual basis

Cash / Accrual Toggle on Displayed Reports
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Chart of Accounts 

Search Box

WHAT’S NEW AND IMPROVED FOR QUICKBOOKS DESKTOP 2018

Search box makes finding 

accounts on long Chart of 

Accounts lists more efficient

Enter text in search box, will 

find any list with that specific 

text or number

Search in Chart of Accounts
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Updated Email 

Security

WHAT’S NEW AND IMPROVED FOR QUICKBOOKS DESKTOP 2018

More secure sending of emails 

from within QuickBooks using 

Gmail, Outlook, Hotmail, etc.

Optional enhanced security 

setting in Send Forms 

preferences

Updated Email Security
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Updated Email 

Security

WHAT’S NEW AND IMPROVED FOR QUICKBOOKS DESKTOP 2018

Requires your Intuit User ID 

and password

Requires Webmail authorization

Access and refresh tokens 

track that you have given this 

authorization

Updated Email Security
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Improvements to 

Selected Inventory 

Reports

WHAT’S NEW AND IMPROVED FOR QUICKBOOKS DESKTOP 2018

All versions of QuickBooks

Selected inventory reports now provide 

option to customize columns of displayed 

data

• Inventory Valuation Summary or 

Detail

• Inventory Stock Status by Item 

• Assembly Shortage by Item

Updated QuickBooks Inventory Reports
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QuickBooks 2018 

Requires Internet 

Explorer 11

Used for help pages, online 

banking, payments, etc.

Regarding Internet Explorer 11

• Included with Windows 10

• Can use with Windows 7 or 8

• Not available for Windows XP 

or Vista

WHAT’S NEW AND IMPROVED FOR QUICKBOOKS DESKTOP 2018

Windows Internet Explorer 11 Requirement
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Mobile Scanning and

Sales Order Fulfillment 

WHAT’S NEW AND IMPROVED FOR QUICKBOOKS DESKTOP 2018

QuickBooks Enterprise with 

Advanced Inventory

Record picked quantities in the 

warehouse on mobile devices

Send updated data back to the 

QuickBooks Enterprise file

Mobile Inventory Scanning and Sales Order Fulfillment Workflow
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Mobile Barcode or 

Serial # Scanning of 

Quantities Picked

WHAT’S NEW AND IMPROVED FOR QUICKBOOKS DESKTOP 2018

Works with barcode capable 

scanners or manually update 

quantities with an Android mobile 

device

Add notes on the mobile device 

to the picklist

Warning messages when 

incorrect quantity picked

Mobile Inventory Scanning
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Pickers –

Create a Vendor  

Warehouse User

WHAT’S NEW AND IMPROVED FOR QUICKBOOKS DESKTOP 2018

Create a vendor record for each 

picker - assigning a new vendor 

type: Warehouse User

These “vendors” now will be 

accessible in QuickBooks and 

on mobile devices to assign to 

pick lists

Sales Order Fulfillment Workflow



#QBVcon

Intuit Proprietary and Confidential

Android App 

Installed on Mobile 

Device

WHAT’S NEW AND IMPROVED FOR QUICKBOOKS DESKTOP 2018

Install the app on any 

compatible mobile barcode or 

phone device

Android phone users, available 

as an app in Google Play:

QuickBooks Desktop 

Warehouse

Mobile Inventory Scanning
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Connect the 

Device(s) to the 

QuickBooks File

WHAT’S NEW AND IMPROVED FOR QUICKBOOKS DESKTOP 2018

To enable: Edit > Preferences, 

Items & Inventory > Advanced 

Inventory Settings > Site 

Operation

Multiple mobile devices, both 

barcode scanners and phones 

can be connected to the 

QuickBooks Enterprise file via the 

Internet

Mobile Inventory Scanning
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Connect Enterprise 

File to Mobile 

Device(s) via Internet

WHAT’S NEW AND IMPROVED FOR QUICKBOOKS DESKTOP 2018

Install the app on the supported 

mobile device(s)

QuickBooks will generate an ID 

to enter into the mobile device 

app to connect the device(s) to 

the QuickBooks Enterprise file

Mobile Inventory Scanning
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Connect Enterprise 

File to Mobile 

Device(s) via Internet

WHAT’S NEW AND IMPROVED FOR QUICKBOOKS DESKTOP 2018

Enter the code and the 

device(s) will be connected to 

the file via the Internet

No need to tether the scanner 

directly to the QuickBooks file

Warehouse users do not need 

to access the QuickBooks file!

Mobile Inventory Scanning
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QuickBooks User 

Generates Picklists

WHAT’S NEW AND IMPROVED FOR QUICKBOOKS DESKTOP 2018

Create pick lists from open Sales 

Orders filtered by picked status

and/or

Filter for Sales Orders that can 

be:

• Fully picked

• Partially picked

• Not Picked

Sales Order Fulfillment Workflow
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Picker Logs Into 

Mobile Device and 

Records Picked Qty

WHAT’S NEW AND IMPROVED FOR QUICKBOOKS DESKTOP 2018

Warehouse user logs into the 

app – their assigned picklists 

display

Scan a barcode or serial 

number or manually type the 

picked quantity

Warning messages display

Sales Order Fulfillment Workflow
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QuickBooks File is 

Updated with Picked 

Quantity

WHAT’S NEW AND IMPROVED FOR QUICKBOOKS DESKTOP 2018

QuickBooks user accepts the 

updates from the warehouse 

mobile devices

QuickBooks user pushes the 

updated picked quantities to the 

Sales Order rows

Sales Order Fulfillment Workflow
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No Mobile Device? 

Simply Print the 

Pick List

Optional workflow includes 

printing the picklist, taking to 

the warehouse, manually 

writing in quantities

QuickBooks Enterprise user 

can then update the rows 

picked on the Pick List

WHAT’S NEW AND IMPROVED FOR QUICKBOOKS DESKTOP 2018

Sales Order Fulfillment Workflow



ToolBox Access 

QuickBooks ProAdvisor 

Program

Learn how the ProAdvisor program gives you 

Accountant ToolBox Access
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QuickBooks ProAdvisor 

Program Offerings

https://quickbooks.intuit.com/accountants/proadvisor/

https://quickbooks.intuit.com/accountants/proadvisor/
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Work with important and useful accountant 

tools while at your client’s using QuickBooks 

Pro, Premier or Enterprise

Reclassify transactions

Troubleshoot beginning balances

Write off small balances

Merge vendors

and so much more!

Accountant ToolBox Access
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Accessing the Accountant ToolBox at the Client Site

ACCOUNTANT TOOLBOX

Join the 

QuickBooks 

ProAdvisor 

Program –

Deluxe or 

Premium Level

Client creates an 

External 

Accountant User 

for you in their file

Log into their 

QuickBooks Pro, 

Premier or 

Enterprise file 

while at the client 

site as the External 

Accountant

Pro or Premier: 

Unlock the 

Accountant 

ToolBox

Enterprise, 

access 

Accountant Tools

Use Accountant 

specific tools to 

simplify your work 

in the file

Step 1 Step 2 Step 3 Step 4 Step 5

* Works with QuickBooks Pro, Premier, Enterprise 
2015 or newer
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Resources

• https://quickbooks.intuit.com/accountants/proadvisor/

• https://payroll.intuit.com/payroll-services/compare-payroll/

• http://enterprisesuite.intuit.com/products/advanced-inventory/

• https://community.intuit.com/articles/1586833

https://qbo.intuit.com/
https://payroll.intuit.com/payroll-services/compare-payroll/
http://enterprisesuite.intuit.com/products/advanced-inventory/
https://community.intuit.com/articles/1586833
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Summary

• Identify new and improved features that will help you and your 

clients work more efficiently using QuickBooks Desktop 2018

• Review the benefits of the QuickBooks ProAdvisor Membership 

with access to the Accountant ToolBox
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